Semester |l

FT-301C STRATEGIC MANAGEMENT

Level of Knowledge:Expert Knowledge

Course Objectives:

* To impart an understanding of the concept of Sgiatdélanagement. The course also
seeks to prepare the student in analytical andsiecmaking skills whereby he/she can
analyze real business problems in the form of csisglies and take decisions
accordingly.

Scheme of Examination:

Total Marks: 100
Internal Marks: 40
External Marks: 60

The external examination will have two Sectionsnll 8. Section A worth 40 marks will consist of
five theory questions out of which a student haattempt any four questions. Section B worth 20
marks will be Analytical (Case/Case let/Researdbdion/Practical problem). The questions may
or may not contain internal choice. The questi@rsttave one or more sub-parts.

Course Contents:
Unit 1: An Overview of Strategic Management:

* Understanding Strategy

» Defining and Explaining Strategy

» Levels at which Strategy operates

» Strategic Decision-making

» Schools of Thought on Strategy Formulation
* The Process of Strategic Management

Unit 2: Strategic Intent:

* Vision

* Mission

» Defining Business

» Goals and Objectives

Unit 3: The General Environment:

* General Environment
* Analyzing the Environment
» Diagnosis of Environment

* Environment Appraisal:
» Concept of Environment,
» Environment Sector & Scanning

» Organizational Appraisal:
» Dynamics of Internal Environment
» Methods & Techniques used for Organizational Agahi



Unit 4: Corporate Level Strategies:

Grand Strategies

Stability Strategies

Expansion Strategies—Diversification
Mergers

Takeovers

Joint Ventures

Strategic Alliances

Retrenchment Strategies
Combination Strategies

Unit 5: Business Level Strategies

Business level Strategies
Generic business,
Tactics for Business strategies.

Unit 6: Strategic Analysis and Choice

The process of Strategic Choice

Corporate level Strategic Analysis:

» Corporate Portfolio Analysis- BCG Matrix
» GE matrix

» Hofer's Product/Market Evolution Matrix
» Directional Policy Matrix

Business Level Strategic Analysis-Experience Cémalysis:
Life Cycle Analysis

Industry analysis

Porter’s Five Forces Model of Industry Attractivese
Strategic group analysis

Competitor analysis

Coming to a Strategic decision.

YVVVVVY

Unit 7: Strategy Implementation:

Activating Strategies:

> Interrelationship between Formulation & Implemeiotat
» Project & Procedural Implementation

» Resource Allocation

Structural Implementation:
» Structures for Strategies
» Organization Design & Change

Behavioral Implementation:

» Leadership Implementation

» Corporate Culture, Politics

» Personal Values, Social Responsibility & Busine$sds

Functional & Operational Implementation:



» Functional Strategies

» Functional, Financial, Marketing, Operational & &aral Plans
» Functional, Financial, Marketing, Operational & aral Policies
» Operational Implementation

Unit 8: Strategic Evaluation & Control:

* An overview of Strategic Evaluation and Control
» Strategic & Operational Control
» Techniques of Strategic Evaluation & Control

Unit 9: Case Module:
(To be presented by the students and will be fatéld by faculty in the class)
» The Strategic Aspirations of Reserve Bank of Ir{@izhar Kazmi)
» Helpage India (Azhar Kazmi)
* What lies in the store for the Retailing Industnyimdia (Azhar Kazmi)
» Bharat heavy Electricals Ltd. Concentrates on thed? Equipment (Azhar Kazmi)
» Striking Back : The Case of TVS Suzuki (Rakesh Kmar & A.N. Ravichandran)
» Cool Competitive Strategies of Whirpool (Azhar Kagm
* Incorporating Corporate Social Responsibility irBtrategy at the Tata group (Azhar
Kazmi)
» Mysore Food limited
Text Readings:

1. Azhar KazmiBusiness Policy and Strategic ManageméMtEd., Tata-McGraw Hill

2. Lawrence R. Jauch, Rajiv Gupta and William F. Gky&usiness Policy and Strategic
Management7™ Ed., Frank Bros and Co.,

3. Thompson and Stricklandstrategic Management-Concepts and Cadé¥ Ed. Tata
McGraw Hill.



FT-302C PROJECT MANAGEMENT

Level of Knowledge Expert Knowledge

Course Objectives

» To acquaint students with project management metimadto develop skills on project
planning, analysis, implementation and control.

Scheme of Examination:

Total Marks: 100
Internal Marks: 40
External Marks: 60

The external examination will have two Sectionsndl 8. Section A worth 40 marks will consist of
five theory questions out of which a student haattempt any four questions. Section B worth 20
marks will be Analytical (Case/Case let/Researdbdion/Practical problem). The questions may
or may not contain internal choice. The questiarsitave one or more sub-parts.

Course Contents:

Unit 1: Project Planning and Phases:

* Need and importance
* Phases of capital budgeting
* Project analysis facts

* Resource allocation framework:
» Investment strategies
» Portfolio planning tools
» Interface between strategic planning and capitdbkting

» Generation and Screening of Project Ideas.

Unit 2: Project analysis:
» Market and demand analysis (Including demand fctetg)

» Technical Analysis and Financial Analysis:
» Cost of Project
» Working capital requirement & its financing.

Unit 3: Project Selection:

* Project cash flows

* Time value of money
» Cost of capital

* Appraisal criteria

* Analysis of Risk.

Unit 4: Project Management and Control:

* Project Organizations
* Planning and Control of project



* Human aspects of project management

 Project control tools:
> Gantt Charts
> Line off Balance

Unit 5: Network techniques for Project Management:

» Basic concepts of networks

» line estimation and determination of critical path:
» PERT models
» CPM models

» Network cost systems and activity crashing
* Resource leveling.

Unit 6: Project Review: Need for reviews:

* Initial review

* Performance evaluation

* Abandonment analysis,

» Evaluating the capital budgeting systems.

Text Reading:

1. Prasanna Chandra. “Project Planning, Analysis,cBelge Implementation and Review”,
New Delhi, Tata McGraw Hill Publications, 2007.

2. Vasant Desai “Project Management” Mumbai, Himal&yblishing House, 2007.

3. R.Panneerselvam and P.Senthilkumar “Project Manag€mNew Delhi, PHI
Learning Private Ltd.,2009.

Suggested Reading:

1. N.P.Agrawal and B.K. Mishra “Project Management'WNBelhi, Ramesh Book Depot,
2008.

2. Bhaveh M Patel “Project Management” New Delhi, \&k&ublishing house Pvt.
Ltd.2000.



FT-303CA MAJOR RESEARCH PROJECT PHASE | (SYNOPSIS,DATA COLLECTION)

Level of Knowledge Expert Knowledge

Course Objectives:

To help the students to understand the ConcepMetidods of Business Research.

To familiarize the students and give them exposti®ynopsis design, objectives

formulations and methodology to be used for datdyais.

To guide the students in questionnaire design andgythe exposure of data collection

To provide the knowledge to the students so thet till be able to plan, design

and execute research proposals

To familiarize the students with the various methotfidata analysis and prepare the
research reports.

Scheme of Examination:

Total Marks: 100
Internal Marks: 50
External Marks: 50

Activities and Marks Distribution:

In the third semester, each student will be alled@uide in their respective specialization. Stislen
will finalize the topic of MRP with the respectivgides and prepare synopsis in the standard
format prescribed by the institute/concerned factithe to time

General format of the synopsis should be:

Cover page containing the research topic, namesiitlite with logo, Name of Guide
and Student.

Introduction/Conceptual Framework

Review of Literature

Objectives

Methodology (Universe, Sample, hypothesis (if amgsearch design (if any)Tools for
data collection and analysis)

Expected Outcomes

References in APA Style

Internal Marks (50):

Synopsis submission to coordinator duly approvehbige (10 Marks) to be awarded
by the faculty/coordinator

Presentation of Synopsis (10 Marks) to be awarged fanel consisting of an expert
and/or coordinator and Guide

Presentation of Questionnaire (10 Marks) to be de@by a panel consisting of an
expert and/or coordinator and Guide

Submission of collected data and synopsis in Sforat (10 Marks) to be awarded by
Guide

Evaluation of data (10 marks) by Guide

External Marks (50):

There will be external evaluation by the externghreiner and internal examiner
appointed by the Principal.



FT-303CB SUMMER TRAINING PROJECT

Level of Knowledge Expert Knowledge

Course Objectives:

* The Summer Training Project aims to widen the sitidgrospective by providing an
exposure to real life organizational & environmeésituations. It is positioned between
first and second year (at the end of second seneste

Duration: 30 - 45 Days

Scheme of Examination:
After completing SIP the student gives the presemtand viva voce as part of evaluation.

Examination Process:

1. Submission of Report
2. Presentation
3. Viva -Voce



FT-304M PRODUCT & BRAND MANAGEMENT

Level of Knowledge Expert Knowledge

Course Obijectives

* To help student understand the concepts of Pra&acBrand, various tools and models
used for challenges faced by today’s managers.

Scheme of Examination:

Total Marks: 100
Internal Marks: 40
External Marks: 60

The external examination will have two Sectionsnll 8. Section A worth 40 marks will consist of
five theory questions out of which a student haattempt any four questions. Section B worth 20
marks will be Analytical (Case/Case let/Researc¢hafion/Practical problem). The questions may
or may not contain internal choice. The questi@arsitave one or more sub-parts.

Unit 1: Introduction to Product:

* Product — definition, levels and classification

* Product focused organization

» Market focused organization

* The Adaptation & Diffusion of new product developrhe
* Seven stages of PLC

* Managerial Application of PLC

* New Product Development Models

* New Product Development Process

Unit 2 : Product Elimination:

* The Importance, Reasons & Scope of Product Deletion
* Identification & Evaluation of Deletion Products
* Implementing the Deletion Decision

Unit 3: Introduction to Brand:

 Brand

* Brand Reflection

» Commodities Vs brands

* Brand Name

* Brand Strategies

» Hofstele Model for understanding Core Value of Bran
» Brand Significance

» Strategic Brand Management Process

Unit 4: Brand Equity, Image and Personality

» Criteria of choosing Brand Elements
» Concept & Principle of Brand equity



Measuring Brand Equity:
> Qualitative
» Quantitative

Brand Image
Brand Personality

Unit 5: Various Concepts associated with Brand:

Brand Positioning

Brand Differentiation

Co-branding

Celebrity Endorsement — Pros and Cons
Brand Building

Brand Extension

Brand Valuation

Global Branding

Unit 6: Managing Brands Over Time:

Brand Repositioning
Adjustment To Brand Portfolio
Brand Architecture

Unit 7: Case Module:
(To be presented by the students and will be fatgld by faculty in the class)

Homemade Ice-cream Limited

Intel’s Entry into Consumer Electronics : Tryingiew trade (ICFAI Workbook)
Brand in search of upward stretch (Harsh V Verma)

Branding by Sensing (Harsh V Verma)

Brand in search of new life (Harsh V Verma)

Text Reading:

1.

abrwn

Product Strategy and Management — Michael BakesaisiHart, Pearson Education
Publication

Product management - Donal R. Lehmann, Russel SeMTiata Macgraw Hill

Brand Management: Y L R Murthy Vikas Publication

Strategic Brand Management - Kevin Lane Keller

Brand Management: S A Chunawalla

Suggested Reading:

PwnhE

Brand Management: U C Mathur Macmillan

Brand Management: S L Gupta Himalaya Publishinggd¢ou

Brand Positioning Strategies for Competitive Adea@y® -Subrato Sen Gupta
Brand Management: Ajay Kumar



FT-305M CONSUMER BEHAVIOUR

Level of Knowledge:Expert Knowledge

Course Objective:
» To familiarize the students with the Basic Conceft€onsumer Behaviour
» To Make the students understand the Role of ITdngdmer Behaviour

Scheme of Examination:

Total Marks: 100
Internal Marks: 40
External Marks: 60

The external examination will have two Sectionsnll 8. Section A worth 40 marks will consist of
five theory questions out of which a student haattempt any four questions. Section B worth 20
marks will be Analytical (Case/Case let/Researdbdion/Practical problem). The questions may
or may not contain internal choice. The questiarsitave one or more sub-parts.

Course Contents:
Unit 1: Introduction to Consumer Behavior:

» Definition, Nature and Scope

» Orientation in the study of Consumer behavior
» Application of Consumer Behavior

* Customer and Consumer

» Understanding Consumers adidrket Segments

Unit 2: Environmental Influences on Consumer behawor:

* Culture, Sub Culture and Cross cultural understagqidi
» Definition and meaning of culture
» Characteristics of Culture
» Concept of Subculture
» Impact of Subculture on Consumer Behavior
» Basic understanding of Cross cultural marketing

* Social Class and Consumer behavior:
> Social Stratification
» Social Class and buying behavior

* Family and Consumer behavior:
» Family life cycle
» Significance of Family in consumer behavior

* Personal Influence

» Diffusion of Innovations:
» Diffusion concept
» Adoption Process
» Factors affecting Diffusion/ Adoption
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» Opinion Leadership Concept and Life style Marketing

* Group Dynamics:
» Types of group
» Factors which play a role in reference group inflees
> Benefits of reference group appeal

Unit 3: Consumer as an Individual:

« Consumer Needs & Motivation

« Consumer Personality and Self Concept:
» Basic Concept
» Personality influence and Consumer Behavior
> Differential threshold — Webers Law
» Self concept

» Consumer Perception:
» Meaning and Definition
» Factors affecting Perception
» Perceptual process
» Factors responsible for perceptual distortion

* Attitudes:
» Concept and characteristics of Attitude
» Relationship between attitude and Behavior
» Factors involved in attitude formation
» Attitude Change

* Learning:
» Components of learning
» Classical conditioning
» Operant conditioning
» Application of Classical Conditioning to Advertigin

Unit 4: Consumer Decision Process:

» Consumer Decision Making Process
» Post purchase Process :Dissonance Satisfactiosatidiaction
» Organizational Buying Process

Unit 5: Consumer Behavior Models:

* Nicosia model

* Howard Sheth Model

» Engel-Blackwell and Miniard Model

* Sheth Family and decision making Model

Unit 6: CRM:

 CRM and Consumer Behavior
» Consumerism & Public Policy issues
» The Darker side of Consumer Behavior and Marketing.

11



Unit 7: Case Module:
(To be presented by the students and will be fatéld by faculty in the class)

e-CRM : a case study (K.K. Shrivastav)

Diamonds are forever (K.K. Shrivastav)

Levis Strauss

Using the power of Reference

On-line Matrimony Services in India (ICFAI Workbopk

Pet Services in India from Bow Bow to Wow Wow (ICPRAorkbook)

Books Recommended:

1.

2.

3.

4.

David L. Loudan and Albert J. Della BiitaConsumer BehaviofNew York, McGraw
Hill, 4™ Edition 1993

Leon G. Schiffman and Leslie lazar Kan@lonsumer BehaviplLondon, Prentice Hall,
6'" Edition 1995.

Dr. S.L. Gupta and Sumitra Pal ,An Indian PerspectConsumer Behavior, Text &
Cases

Satish K Batra and S H H Kazmi, Consumer Behavibext & Cases

Suggested Readings:

1.

2.

William L. Wilkie, Consumerbehavior New York, John Wiley and Sons’ Edition,
1994.

Dish Sheth, Banwari Mittal and Bruce I. Newman, 8amer behavior and Beyond,
1999.

12



FT-306M ADVERTISING & SALES PROMOTION

Level of Knowledge Expert Knowledge

Course Objectives
* To help student understand the concepts of AdvegtiSales, Sales Promotion &
various tools and models used for challenges fagegdday’s managers.

Scheme of Examination:
Total Marks: 100
Internal Marks: 40
External Marks: 60

The external examination will have two Sectionsn@l 8. Section A worth 40 marks will consist of
five theory questions out of which a student haattempt any four questions. Section B worth 20
marks will be Analytical (Case/Case let/Researc¢hafion/Practical problem). The questions may
or may not contain internal choice. The questi@arsitave one or more sub-parts.

Course Content:

Unit 1: Advertising — An Introduction :
* Meaning, definition and characteristics
 PLC & Advertising
* Indian Advertising industry scenario
» Functions & objectives of Advertising
« DAGMAR and AIDA model
» Types of advertising
» Advertising Agency
* Agency Structures
» Essentials of effective advertising
* Internet advertising
» Advertising as career
* Advertising ethics

Unit 2: Advertising Copy Decisions:
* Meaning, definition and features
» Types of advertising copy
* Elements of copy
» Advertising copy devices
» Essentials of a good copy
* Common mistakes
* Measuring advertising effectiveness
» Advertising appeals

Unit 3: Media Planning & Strategy:
* Types of media
* |dentifying the Target Market
» Establishing Media Objectives
» Develop & Implementing Media Strategies

13



* Media Evaluation

Television

Buying TV Time

Audience Measures

Radio

Newspapers

Newspaper Advertising & Types
Purchasing, Circulation & Readership
Purchasing Space

YVVVYVVVVY

* Planning Advertising Campaign
» Advertising Budget

Unit 4: Introduction to Sales Promotion & Personal Selling
» Definitions-Sales Promotion
» Factor Influencing Sales Promotion Growth
* Advantages & Drawbacks of Sales Promotion,
* Promotion of Sales Force
* Introduction to Personal Selling
* Personal Selling Process

Unit 5: Sales Planning & Promotion:
* How Sales Promotion Affects Sales
» Sales Promotion Objectives & Budget Allocation
» Sales Promotion Design Issues
* Planning Guidelines & Evaluation

Unit 6: Sales Promotion-Tools & Techniques
» Types of Sales Promotion
» Sales Promotion Tools & Technique
Price Deals
Bonus-Packs
Refunds & Rebates
Coupons
Contests & Sweepstakes
Sampling
Premiums
Exchange or Buyback Offers
Money back offer
Frequency programs
Event marketing
Installments offer
Trade fairs and exhibitions

VVVVVVVYVYVVVYYY

Unit 7: Case Module:

(To be presented by the students and will be fatsldl by faculty in the class)
* Pearls Soap (SHH Kazmi & Satish Batra)
» Panorid pain Balm (SHH Kazmi & Satish Batra)
» Pizza Hut (SHH Kazmi & Satish Batra)



* Lintas
* Pond’s Cream (Manindra Mohan)

Text Reading:
1. S HH Kazmi & Satish K Batra: Advertising & SalesoRmotion
2. Foundations of Advertising S A Chunawalla K C $eth
3. Aaker, Batra & Myers: ADVERTISING MANAGEMENT; Preice Hall India.

Suggested Reading

1. Wright, Winter & Zeigler: ADVERTISING; Tata McGrawmill.

2. Wells, Burnett &Moriarty: ADVERTISING PRINCIPLES AN PRACTICES, Prentice-
Hall

3. Sandage, Fryburger & Rotzoll: ADVERTISING; Irwin.

4. J. T Russel & Ronald Lane: KLEPPNER'S ADVERTISINBR®CEDURE; Prentice
Hall.

5. Don E. Schultz: STRATEGIC ADVERTISING CAMPAIGNS; NCTBusiness Books.

15



FT-304F BUSINESS TAXATION

Level of Knowledge:Expert Knowledge

Course Objectives:

* To Lay a Conceptual Framework for Business Taxation

» To develop an ability in the student to apply tletical concepts with Practical life
problems

Scheme of Examination:

Total Marks: 100
Internal Marks: 40
External Marks: 60

The external examination will consist of six quest out of which first question will be of 20
marks and will be compulsory. From the remaining fquestions, a student will have to attempt
any four questions. The questions may or may notato internal choice. The questions can have
one or more sub-parts.

Course Contents:
Applicable Assessment Year 2010-11, Previous Yead@-10.

Unit 1: Basic Concepts and framework of Income taAct, 1961.:
* Framework

» Definitions under Income Tax Act ,196:
Assessment Year

Previous Year

Income

Person

Assessee

YVVYY

* Residential Status and Incidence of Tax

Unit 2: Income under the ‘head Income from Salaries

» Basis Of Charge
* Meaning

* Terms Taxable as Salary:
Advance Salary

Leave Encashment/Salary
Bonus

Gratuity

Pension

» Taxability of Allowances U/s 10(14) and Rule 2BB:
» House Rent Allowance U/s 10(13A)
» Traveling allowance
» Conveyance Allowance
» Dally, Helper, Uniform allowance

YVVYVYY
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» Children education allowance (Rule 2BB)
» Transport allowance(Rule 2BB)

» Taxability of perquisites:

Concept of Specified and Non specified employee

Valuation of Rent-free unfurnished and furnishedosmemodation
Leave Travel Concession

Free Education

Lunch/refreshments

YVVYYVY

* Permissible deduction:
> Entertainment Allowance
> Professional Tax

» Simple problems based on the computation of Incvora Salaries

Unit 3: Income under the head ‘income from House poperty:
* Basis of Charge

» Concept of House property:
» Concepts of Municipal Valuation, Fair Rent, Staridamt
» Determination of Gross and Net Annual value

» Deductions u/s 24:
» Standard deduction
> Interest on Borrowed capital

» Special Cases:
» One House property Partly Let out and Partly Setiupied
» More than One House, Deemed to be let out

* Simple problems based on the computation of Incfvora house property

Unit 4: Income under the head ‘Profit and gains obusiness and professions:

» Basis Of charge
» Basic concepts and principles

» Specific allowances:

Rent, Rates , Taxes, Repairs, Insurance for bigldia 30
Repairs and insurance of Machinery plant and furait/s 31
Depreciation u/s 32 and concept of block of Assets
Expenditure on scientific research u/s 35

Amortization of Preliminary expenses u/s 35D

Interest on borrowed capital 36(1)(iii)

Bad Debts u/s 36(1)(vii)

Conditions under Section 37(1)

YVVVVYVYVVVY

» Specific disallowances:
» Income tax , Wealth Tax, Security Transaction Tax
> disallowances in respect of expenditure exceedisg 2,000 U/s 40A(3) and
exception in Rule 6DD

» Special Provisions of Section 44AD,44AE,44AF
 Maintenance of Books of accounts U/s 44AA

17



» Tax Audit U/s 44AB

Unit 5: Income under the Head ‘Income from CapitalGains:
* Basis Of Charge

» Concepts:

Capital Assets

Short term and Long Term Capital Assets
Cost of Acquisition and Improvement
Indexation

Transfer

Full Value of Consideration

YVVVVVY

» Simple problem based on Computation of Capitahgdiincluding Shares)

» Deduction:
» Capital gain arising from the transfer of residahiouse property u/s 54,
» Capital gain arising from the transfer of landdug& agricultural purposes u/s 54B ,
» Capital gain not to be charged on investments itarebonds 54EC ,
» Capital gain arising from the transfer of a longrnecapital asset other than a house
property u/s 54F

Unit 6: Income under the head ‘Income from Other Saorces:

» Basis of Charge
* Concepts and Few examples of Income from othercesur

» Taxability of :
» Income from Lottery, Horse race Puzzles and camdega
» Interest on securities
» Simple concepts relating to dividend and dividersdrdbution Tax

Unit 7: Permissible Deductions under Chapter VIA:

» Deductions relating to:

Section 80C relating to various investments

Section 80CCC Pension fund

Section 80D in respect of medical insurance premium
Section 80DD relating to dependent being a perstndisability
Section 80DDB relating to medical treatment

Section 80E in respect of repayment of Educatian lo

YVVVVYVY

Unit 8: Return of Income and TDS:

» Basic concepts relating to filing of return:
» Filing of return U/s 139(1)
» Concepts relating to PAN u/s 139A
» Tax return preparers Scheme 139B

 Tax Deducted at Source:
» TDS provisions relating to Salary u/s 192
» Interest on securities u/s 193
» Interest, other than Interest on securities ufsA19
» Payment to Contractors U/s 194C

18



> Rent U/s 194-]|
Text Readings:
1. Student guide to Income Tax Dr. V.K Singhania Drriiba Singhania, Taxman
publications

2. Income Tax S.C., Saklecha, Satish Publication House

Suggested Readings:
Direct Taxes ,T.N Manoharan, Snow White Publicaion

19



FT-305F FINANCIAL ENGINEERING

Level of Knowledge:Expert knowledge

Course Objectives:

* To Lay a Conceptual Framework for Financial Engiimee
* To develop an ability in the student to apply tletioal concepts with Practical life
problems

Scheme of Examination:

Total Marks: 100
Internal Marks: 40
External Marks: 60

The external examination will consist of six quess out of which first question will be of 20
marks and will be compulsory. From the remaining fquestions, a student will have to attempt
any four questions. The questions may or may notato internal choice. The questions can have
one or more sub-parts.

Course Contents:
Unit 1: Introduction to Derivatives:
» Concept and terminology of derivatives

» Types of derivatives:
» Future
» Forward
» Options
» Swaps

» Concept of Participants:
» Hedgers
» Speculators
» Arbitragers

* Use of Derivatives

* Types of Order

* Types of Margin

» Concepts and Introduction to Stock Exchanges (BSE,NCDEX,MCX)

Unit 2: Futures Contract:

» Concepts relating to futures
» Difference between futures and forward Contracts
» Concept of Margin, Clearing house, Hedging

» Types of futures:
» Stock Index futures
> Interest rate futures
» Foreign exchange and currency futures etc.
» Undervalued, Overvalued and Correctly Priced waflerence to Future

» Simple problems based on valuation of futures
20



Unit 3: Option Contracts:

» Concept and Meaning of Options
» American Option
» European Option

» Concepts relating to the following:
» In the Money Option (ITM)
» At the Money Option (ATM)
» Out of the Money Option (OTM)

* Types of Options:
» Call Option
» Put Option

» Following trading Strategies Involving Bull and Bea
» Straddle
» Strangle
» Strips and Straps
> Butterfly

* Preparation of Pay-Off table / Graphs from the pofrview of:
> Holder
» Writer

» Valuation of Options using:
> Black-Schole Model
» Call-Put Parity Theory

Unit 4: Swaps:

* Introduction and meaning of Swaps

» Mechanics of Swaps transactions

* Interest rate Swap

» Currency rate swaps

» Simple Problems based on Interest Rate and Curigways

Text Readings:

1. John C Hull, Options, Futures and Other Derivativdsw Delhi Pearson Education
Asia publication.
2. Derivatives, SSS Kumar, Prentice Hall Pvt Ltd.
3. N D Vohra, B R Bagri, Tata McGraw Hill Publication
Suggested Readings:

Derivatives, Robert A Strong, Thomson Publications
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FT-306F WORKING CAPITAL MANAGEMENT

Level of Knowledge:Expert Knowledge

Course Objectives:

* To Lay a Conceptual Framework for Working Capitardgement
* To develop an ability in the student to apply tletical concepts with Practical life
problems

Scheme of Examination:

Total Marks: 100
Internal Marks: 40
External Marks: 60

The external examination will consist of six quess out of which first question will be of 20
marks and will be compulsory. From the remaining fquestions, a student will have to attempt
any four questions. The questions may or may notato internal choice. The questions can have
one or more sub-parts.

Course Contents:
Unit 1: Basic Concepts and overview of Working capal:

» Concept and definition of working capital

* Need of working capital

» Components of Working capital

* Meaning of Operating cycle, Current Assets and €uriabilities

Unit 2: Computation of Working Capital:

» Simple problems relating to computation of workaagpital using
» Operating Cycle method

» Current assets and Current liabilities Method using
o Normal Problems
o0 Cash Cost Method

» Mini Cases based on Working Capital

Unit 3: Cash Management:

* Introduction and basic concepts of Cash Management

» Objectives of Cash Management

» Preparation of Cash Budget

» Concept of Cash Management Technique

* Mini Cases and simple problems based on Cash Marage

Unit 4: Inventory Management:

» Basic Concepts
» Trade-off Between cost and benefit associated leitél of Inventory
» Techniques for managing Inventory and problemsdase

» EOQ Model

22



» ABC Analysis
» Pareto Analysis

* Inventory Management using the following Methodd aroblems based on:
» Firstin first out (FIFO)
» Last in first out(LIFO)
» Weighted average
> Base Stock Method

» Computation of Stock out Costs and problems baaestack out
* Mini Cases based on Inventory Management

Unit 5: Receivable Management:

» Basic Concept

» Category of Cost Related to receivables
» Concept of Credit Policy and Bad debts
» Concept of Factoring

* Problems based on:
» Effect of change in Credit Policy
» Using Factoring

* Mini Cases based on Receivable Management

Unit 6: Working Capital Financing:
* Trade

* Bank Credit:
» Cash Credit/Over draft
» Bill purchase/discounted
» Terms loans
> Letter of Credit
» Hypothecation, Pledge ,Mortgage, charge

» Commercial Paper

» Certificate of Deposit

» Factoring

* Mini Cases based on Working Capital Financing

Text Readings:

1. 1 M Pandey, Vikas Publication House Pvt. Ltd.
2. Prasanna Chandra, Tata McGraw-Hill Publishing Cangdad.
3. Shashi K.Gupta & RK Sharma

Suggested Readings:

M Y Khan and P K Jain, Text and Problems and Cas¢a McGraw-Hill Publishing
Company Ltd.
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FT-304H HR LAWS

Level of Knowledge:Expert Knowledge

Course Objective:

» To provide exposure to students to understand Iglghe various laws related to
Industrial Relations, Labour Laws and compensagidteward Management

Scheme of Examination:

Total Marks: 100
Internal Marks: 40
External Marks: 60

The external examination will have two Sectionsrdl 8. Section A worth 40 marks will consist of
five theory questions out of which a student haattempt any four questions. Section B worth 20
marks will be Analytical (Case/Case let/Researc¢hafion/Practical problem). The questions may
or may not contain internal choice. The questi@rsitave one or more sub-parts.

Course Contents:

Part |: Industrial Relations & Labour Laws:

Unit 1: Trade Union Act and Industrial Disputes:

* Trade Unions Act, 1926:Trade Unions, Registration of Trade Unions, Caatielh of
Registration and Appeal, Rights and Privileges Begistered Trade Union,
Dissolution, Penalties

* Industrial Disputes Act, 1947:Industrial Disputes, Authorities under the Act-
Conciliation machinery, Adjudication Machinery. Pealure, Powers and Duties of
authorities, Strikes and Lock-Outs, Lay-Off andi@ethment, Penalties

Unit 2: Workers Participation in Management and Colective Bargaining:

» Workers Participation in Management: Meaning, Objectives, - Essential Conditions,
Forms of WPM

» Collective Bargaining: Meaning, Functions, Process, Importance of Collecti
Bargaining to Employer and Employees

Unit 3: Factories and E.S.1.C Act, 1948 and Paymerratuity:

» Factories Act, 1948:Definitions, Health, Safety and Welfare provisiamgler the act,
Working Hours of Adults, Annual Leave with WagegnBlties

» E.S.I.C Act, 1948:Applicability of the Act, Definitions, Administratn of the Scheme,
Contributions, Benefits, Penalties.

» Payment of Gratuity Act, 1972:Meaning, Definition, Payment of Gratuity,
Nomination, Determination of Gratuity, RecoveryGfatuity, Penalties and offences.
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Part-1l: Introduction to Compensation Management and Related Laws

Unit 4: Wage and Salary Administration:
» Definition
» Goals/Objectives
* Job Evaluation
* Methods of Wage Fixation
» Factors Affecting Wage Concept of Pay of Perforneanc
* Fringe Benefits

Unit 5: Payment of Wages and Minimum Wages Act:
» The Payment of Wages Act, 193@efinition, Application, Rules for Payment of
Wages, Deductions from wages, Appeal, Penalty féer@es.

* The Minimum Wages Act, 1948:0bject, Definitions, Fixation and Revision of Wages
Safeguards in Payment of Minimum wages, OffencesRemalties

Unit 6: The Employee’s Provident Fund and PaymentfoBonus Act:

» The Employees’ Provident Fund Act, 1952Application of the Act, Definitions,
Employees Provident Fund Schemes, Employees PeSistteme and Fund,
Employees’ Deposit Linked Insurance Scheme and FAddhinistration of the
Schemes, Determination of Money due from EmployResalties.

» The Payment of Bonus ActObject, Eligibility and disqualification for Bonus,
Determination of Bonus, Inspectors, Penalties

Unit 7: Case Module:
(To be presented by the students and will be fatéld by faculty in the class)
» Performance vs. Trade Union Role in Collective Barmng. (P. Subbarao)
» Grievance Procedure vs. Collective Bargaining (Bb&uao)
* Smart Beginning ( VSP Rao)
» Balbir: The Union Man (VSP Rao)
» Workmen’s Compensation (VSP Rao)

Text Readings:
1. R.C. Chawla and K.C. Garg, Industrial Law, Ludhiakalyani Publishers, 1993.
2. N.D. Kapoor, Handbook of Industrial Law, Sultan @& Sons, New Delhi.
3. Garry Dessler, Personnel/ Human Resource Managetmamon, Prentice Hall, 1994
4. P. Subbarao, Essentials of Human Resource Managemendustrial Relations-IlI
Edition, Himalaya Publishing House, Mumbai.

Suggested Reading:

1. J.K. Bareja, Industrial Law, New Delhi, Galgotialdfishing Co., 2001.
2. VSP Rao, Human Resorce Management, 2nd EditiorelBublications, A, 45Naraina
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FT-305H HUMAN RESOURCE DEVELOPMENT

Level of Knowledge: Expert Knowledge

Course Objective:

» The course is designed to inculcate in studentiear awinderstanding of various aspects
involved in developing human Resources, HR Syst®rRsocesses and equip them with the
techniques.

Scheme of Examination:

Total Marks: 100
Internal Marks : 40
External Marks: 60

The external examination will have two Sectionsnll 8. Section A worth 40 marks will consist of
five theory questions out of which a student haattempt any four questions. Section B worth 20
marks will be Analytical (Case/Case let/Researdbdion/Practical problem). The questions may
or may not contain internal choice. The questi@rsitave one or more sub-parts.

Course Contents:

Unit 1: Introduction to HRD:
» Definition and Concept
* Characteristics of HRD
« HRD Methods
* Role of an HRD Manager
* Need for HRD
* Need for HRD in the Indian Context

Unit 2: Planning and Organizing the HRD System:
* Planning the HRD System
* HRD Philosophy
* HRD Objectives
» HRD Policies and Practices
* HRD Sub-Systems
» HRD Strategy and Action Plans

Unit 3: Training and Development:
» Training and Development Needs
* Methods of Training
* Methods of Executive Development
» Evaluation of Training Programmes
» Career planning and Succession Planning

Unit 4: Performance Management:
* Introduction to Performance Management
» Concepts and Principles
» Balance score Card approach to performance manageme
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Performance appraisal and its methods

Unit 5: Behavioral Devices:

FIRO-B
Johari Window
Transactional Analysis

Unit 6: HRD Competencies:

Challenges

Professionalism in HR

Myths and Realities of HRD

Competencies Needed

Auditing HRD Competencies

Individual Interviews, Group Interviews, Observatio
HRD Audit Instruments

Unit 7: Case Module:
(To be presented by the students and will be fatéld by faculty in the class)

Performance Management Systems at Titan (S.K. 8hati
Performance Management System in Infosys (S.K.i8hat
Politics and Performance Appraisal (P. Subba Rao)
Evaluation of Executive Development Program (P. i)
Training Expenditure: Cost or Investment (P.Subiara

Text Readings:
1. P.C. Tripathi, Human Resource Development, Sultaan@ & Sons, New Delhi. (2010)
2. S.K. Bhatia, Performance Management, Deep & Dedghications, New Delhi. (2007).
3. P.P. Arya & B.B Tandon, Human Resource Developni2egp & Deep Publications,

New Delhi. (2007).

Suggested Readings:
1. Kuldeep Singh, T.V Rao- Selected Readings in HRda™McGraw-Hill, New Delhi
2. P. Subbarao, Essentials of Human Resource Managememndustrial Relations-I11I

Edition, Himalaya Publishing House, Mumbai.
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FT-306H CHANGE MANAGEMENT AND OD

Level of Knowledge:Expert Knowledge

Course Objective:

» The course is intended to help students to undetstarious implications of Change
Management and provide interventions for orgaroreati Development

Scheme of Examination:

Total Marks: 100
Internal Marks: 40
External Marks: 60

The external examination will have two Sectionsnll 8. Section A worth 40 marks will consist of
five theory questions out of which a student haattempt any four questions. Section B worth 20
marks will be Analytical (Case/Case let/Researdbdion/Practical problem). The questions may
or may not contain internal choice. The questiarsitave one or more sub-parts.

Course Contents:

Unit 1: Change Management:
» Defining
* Need for Change.
» Types of organizational change.
» Forces of organizational change.
» Resistance to Change

Unit 2: Organizational Change Models and its Proces
* Change Models
* Understanding the change process
* Leading the Change Process
» Facilitating the Change

Unit 3: Organizational Culture and Change:
* Meaning
* Types of Culture
* OCTAPACE Culture
» Designing Strategy for Cultural Change

Unit 4: Organization Development
* Introduction
» Definition
» History
* Assumptions
* Values and Beliefs in Organization Development (@B Transformation.

Unit 5: OD Foundations and Action Research:
* Foundations of OD
 OD Process
* Action Research and OD
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Unit 6: OD Interventions:
* Overview
* Types
» Team Interventions, Inter-Group Interventions, Cozhensive and Structural
Interventions

Unit 7: Case Module:

(To be presented by the students and will be fatéld by faculty in the class)
* Out with the old, In with the new (R.L Nandeshwar)
* The Golden Bank (R.L Nandeshwar)
* Wal-Mart’s World (Stephen.P. Robbins and Seema lang

Text Readings:
1. R.L. Nandeshwar, Balakrishna Jayasimha, ChangeKaowvledge Management —Ist
Edition Excel Books, New Delhi
2. Stephen P. Robbins and Seema Sanghi, Organizat&halvior, New Delhi, Prentice
Hall, 13" edition.
3. Wendell L. French and Cecil N. Bell Jr., OrganiaatiDevelopment, New Delhi,
Prentice Hall, 5th Edition, 1999.

Suggested Readings:
1. Don Harvey and Donald R. Brown, An Experiential Apgch to Organizational
Development, New Jersey, Prentice Hall Inc., 1996.
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FT-3041 OBJECT ORIENTED PROGRAMMING USING C++

Level of Knowledge:Expert Knowledge

Course Objective:

Object Orientation is a new approach to understaacdomplexities of the real world. In
contrast to the earlier approaches like procedetal object orientation helps to
formulate the problems in a better way giving highliability, adaptability and
extensibility to the applications. This course ddféghe Modern Programming Language
C++ that shall help the students to implement teous concept of Object Orientation
practically. The students will be able to progranthe Object Oriented Technology with
the usage of C++.

Scheme of Examination:

Total Marks: 100

Internal Marks: 20
Practical Marks 20
External Marks: 60

The external examination will consist of six quest out of which first question will be of 20
marks and will be compulsory. From the remaining fquestions, a student will have to attempt
any four questions. The questions may or may notato internal choice. The questions can have
one or more sub-parts.

Course Content:
Unit 1: Object Oriented Programming:

* Introduction
* Procedure Oriented Programming Vs. Object OrieRi@giramming (OOP)

* Overview:

Objects

Classes

Encapsulation

Data Binding

Inheritance and Polymorphism
Dynamic Binding

Message Passing.

YVVVVYVVY

Unit 2: Review of constructs of C used in C++:
e Variables

» Type Declarations:
» User defined Data Types
» Increment and Decrement Operators
» Relational and Logical Operators
» If then else clause
» Conditional Expressions

* Input and Output statement:
» Loops
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Switch Case

Arrays

Structure

Unions

Automatic

External and Static Data Members and Member Fumctio

YVVVVVY

* Pointers, Preprocessor Directives

Unit 3: Arrays & Pointers:

* Arrays of Objects

» Pointer to Object

» this Pointer

* Function:

General form
Prototypes
Returning
Passing Objects to Functions Returning Objects
Friend Function
Recursion
References.

YVVVYVVVY

Unit 4: Inheritance:

* Multilevel and Multiple Inheritance

» Constructor

» Destructor and Inheritance

* Private

* Public and Protected Access Specifies
* Function and Operator Overloading.

Unit 5: Templates:

* Virtual Function

» Pure Virtual Function

* Polymorphism

* Generic Functions

» Generic types

* Overloading of Templates and Functions

» Standard parameters with Template Functions
» Applying Generic Functions

* Generic Class

» File and Exception Handling
» Introduction to Templates and Exception Handling
> File Classes
» Opening and Closing a file
» Reading and writing a Text File
» Detecting EOF



Text Readings:

1. E. Balagurusamy;Object Oriented Programming with C++”, Tata McGraw Hill
Pub. Co. Ltd., New Delhi, 2000

2. Robert Lafore,"Object Oriented Programming in Turbo C++”, Galgotia Pub. Pvt.
Ltd., New Delhi, 2000

Suggested Readings:

1. Herbert Schildt, “C++ : The Complete Reference”talrdcGraw Hill Publishing
Company Ltd., New Delhi, 1999

2. D. Ravichandran, “Programming with C++”, Tata Mc@®r&lill Pub. Co. Ltd., New
Delhi, 2000
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FT- 3051 COMPUTER NETWORKS

Level of Knowledge:Expert Knowledge

Course Objective:
* The objective of this course is to help studentauumoerstand the concepts of Data

Communication and Computer Networks and relatatesand their use in organization
and processing complex business information.

Scheme of Examination:

Total Marks: 100
Internal Marks: 40
External Marks: 60

The external examination will consist of six quess out of which first question will be of 20
marks and will be compulsory. From the remaining fquestions, a student will have to attempt
any four questions. The questions may or may notato internal choice. The questions can have
one or more sub-parts.

Course Contents:

Unit 1: Computer Networks:

* Introduction

» Distributed Systems

* Network Goals & its Applications
* Protocol Hierarchies,

* Network Architecture

» Design Issues for the Layers:
» Simplex
» Half-duplex
» Full-duplex

* Interfaces and Services:
» Connection Oriented
» Connection less Services
» Service Primitives.

Unit 2: Reference Models

» The OSI Reference Model
 The TCP/IP Reference Model
» Comparison and Critique of the OSI and TCP/IP Refee Models.

Unit 3: Physical Layer:

» Concepts of Data Transmission
* Transmission media

* Guided and Unguided Media

» Digital and Analog Transmission
* Transmission Impairments
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» Multiplexing:
> TDM
> WDM
> FDM

» Switching Techniques:
Circuit

Packet and Message
Cellular Radio
Wireless Transmission
Modems

DSL

Cable Modem

* |SDN:

> Introduction

» ISDN Channels
» |ISDN Layers
>
>

YVVVYVYVVY

Services
Communication Satellites.

Unit 4: Data Link Layer:

* Framing, Error Control

* Flow Control

» Unrestricted Simplex

» Simplex Stop-and-Wait Protocol

* Sliding Window Protocols:
» HDLC
> SLIP
> PPP

* Network Layer:
» Internal Organization
» Routing
» Congestion
>

Routing:

Shortest Path

Multipath

Congestion Control Algorithm
Preallocation of Buffers

Choke Packets

0 Deadlocks and Services of Network Layer.

O O O0OO0O0o

* Transport Layer:

» Services of Transport Layer,
» Transport Protocols
» Connection Management.

Unit 5: Upper OSI layers:



Session Layer and Transport Interaction

Presentation Layer:

» Translation

» Authentication

» Data Compression

Application layers:

» Message Handling System(MHS)
> File transfer

» Access and Management (FTAM)

Transmission Technology:
» Broadcast Networks

» Point-to-Point Networks
LAN

MAN & WAN Topologies
Wireless Networks
Internetworking

o Introduction to Bridges

O O oo

Routers
Switches
Gateways
Repeaters

Y VVVY

Introduction Functioning and Services:
o Novell Netware

0 Window NT

o0 NOS (Network Operating Systems)

Text Reading:

1.
2.
3.

Andrew. S. Tannanbaum, “Computer Networks”, Poeatiall 2006.
Behrouz A. Forouzan, “Data Communication and Neking”, Tata
McGraw Hill Pub. Co. Ltd., New Delhi, 2006.

Suggested Readings:

1.
2.

3.

Martin, J.,"Computer Networks and Distributed Processing’, Prentice-Hall, 1985.
Tom Sheldon;Encyclopedia of Networking”, Tata McGraw Hill Pub. Co. Ltd., New
Delhi, 1998.

William Stallings,“Data and Computer Communication”, Prentice Hall India, New
Delhi, 2001.

William A. Shay, “Understanding Data Communications and Networks’, Vikas
Publishing House, New Delhi, 2001.

Parag Diwan and Dharam Bir SingtComputer Networks Driven e-Commerce
Technologies’, Excel Publisher Pvt. Ltd., New Delhi, 2000.

S. KeshaviAn Engineering Approach to Computer Networking” ,

Addision- Wesley Longman (Singapore) Pte. Liew Delhi, 2001.

. D.E.Comer, “Data and Network Communication” Delnfdmomson Learning Singapur

2000.
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FT-3061 SOFTWARE ENGINEERING

Level of Knowledge Expert Knowledge

Course Objective:

* The objective of this course is to help studentsitderstand the basics of Software
Engineering, Project Management, Software Qualiy eelated issues and their use in
organization and processing complex business irdtam.

Scheme of Examination:

Total Marks : 100
Internal Marks : 40
External Marks : 60

The external examination will consist of six quest out of which first question will be of 20
marks and will be compulsory. From the remaining fquestions, a student will have to attempt
any four questions. The questions may or may notato internal choice. The questions can have
one or more sub-parts.

Course Contents:

Unit 1: The Product and the Process

* The Evolving Role of Software

» Software Characteristics A layered Technology
* Process

* Methods and Tools

* The Software Process

» Software Process Models

* Linear Sequential Model

* Prototyping Model

* RAD Model

* The Incremental Model

* The Spiral Model

» The Concurrent Development Model
» The Component-Based Development
* The Formal Methods Model

* Fourth Generation Techniques.

Unit 2: Projects Management Concepts, Software Prass and Project Metrics

* The Management Spectrum:
» The People
» The Product, The Process

* The Project Measures, Metrics, and Indicators
* Metrics in the Process and Project Domains

» Software Measurement

* Reconciling Different Metrics Approaches
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* Metrics for Software Quality
* Integrating Metrics within the Software Engineerfgcess.

* Project Scheduling and Tracing:

Basic Concepts

The Relationship Between People and Effort
Defining a Task Set for the Software Project
Selecting Software Engineering Tasks
Refinement of Major Tasks

Defining a Task Network, Scheduling
Earned Value Analysis

Error Tracking

The Project Plan.

YVVVVYVYVYVYYYVY

Unit 3: Software Project Planning, Risk Analysis ad Management:

» Observations for Estimation
» Project Planning Objectives

» Software Scope, Resources
» Software Project Estimation
» Decomposition Techniques

» Empirical Estimation Models
* The Make/Buy Decision

* Automated Estimation Tools

* Reactive versus Proactive Risk Strategies:
Software Risks

Risk Identification

Risk Projection

Risk Refinement

Risk Mitigation, Monitoring, and Management,
Safety Risks and Hazards.

YVVVVYY

Unit 4: Software Quality Assurance:

* Quality concepts, the quality movement

» Software quality assurance, software reviews

* Formal technical reviews

* Formal approaches to SQA

» Statistical software quality assurance

» Software reliability, mistake-proofing for software
* The ISO 9000 quality standards

e SQAPIlan

» Software Testing Techniques & Strategies:

Objectives white box testing methods

Black box testing

Testing for specialized environments

Architectures

Applications

A strategic approach to software testing, strategices
Unit Testing, Integration Testing

YVVVVYVYVY



» Validation Testing
» System Testing and the Art of Debugging.

Unit 5: Analysis & Design Concepts and Principles:

Mechanics of structured analysis

Data flow design and Entity Relationship design
Overview of Object Oriented Design Concepts
Design Concepts and principles

Effective modular design

Data modeling.

Client/Server Software Engineering, Re-engineering:
The Structure of Client/Server Systems

Software Engineering for Client/Server systems
Analysis modeling issues

Design for Client/Server systems and testing issues
Software Maintenance Software Re-engineering
Software reengineering process model

Reverse engineering

everse engineering user interfaces restructuring:
Code restructuring
Data restructuring
Forward engineering
Economics of reengineering
Introduction to CASE.

VVVVVA VVVVVVY

Text Readings:

1.

2.
3.

Roger S. PressmafSoftware Engineering”, 6" Ed., Mc Graw Hill Inc., New York,
2005.

Pankaj Jaloté Software Engineering Narosa Publishing Housé®2Edition 1999

lan Sommerville ‘Software Engineering Pearson Education™Edition 2006.

Suggested Readings:

. Martin L. Shooman;Software Engineering”, McGraw Hill International Book
. company, New Delhi, 1985
. Richard E.Fairely;Software Engineering Concepts’, Mc Graw Hill Inc. New York,

1997

G. Meyers,“The Art of Software Testing”, Willey-Inter-Science, 1979.

Bruce I. Blum,“Software Engineering- A Holistic View”, Oxford University Press,
New York, 1992

uramah Finzi, Software Testing in Real World', Addison-Wesley, New Delhi, 2000
Barbara ktchenhamSoftware Metrics” , Blackwell, UK, 1996
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FT-304P: PRODUCTION PLANNING AND CONTROL

Level of Knowledge Expert Knowledge

Course Objectives

* The course is design to equip the students witltdimeepts of Production Planning and
Control (PPC). The emphasis will be on the appbeabf concepts and tools used in
PPC for achieving efficiency and quality superiprit

Scheme of Examination:

Total Marks: 100
Internal Marks: 40
External Marks: 60

The external examination will have two Sectionsrdl 8. Section A worth 40 marks will consist of
five theory questions out of which a student haattempt any four questions. Section B worth 20
marks will be Analytical (Case/Case let/Researc¢hafion/Practical problem). The questions may
or may not contain internal choice. The questi@rsitave one or more sub-parts.

Course Contents:
Unit 1: Introduction to Production Planning and Control:

* Production Management Technologies
» Evaluation

« PPC

« PLC

* Appropriate Technology

» Decision in Production systems

* Planning Horizon Type decision

* Market Driven System:
» Wheel and Hub
» World Class Manufacturing
» Lean Production

» Agile manufacturing and lean v/s Agile Need of PPC
* Functions of PPC

» Factors Influencing PPC in the Organization

* Manufacturing Methods

* Managerial Policies

* Pre-requisites of PPC.

Unit 2: Materials Planning and Control:

* Input Required for Materials Planning and Control

» Steps in Materials Planning and Control

* Techniques of Materials Planning and Control

* Machining Allowances, Make or Buy Decision

» Scientific Stock Control Techniques (Inventory GohiModels).
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Unit 3: Factors Influencing Process Planning:

Step in Process Planning
Process Selection
Tools control.

Unit 4: Manufacturing resource planning (MRP 11):

Introduction

Aggregate production planning

Master production scheduling

MRP 1l (Introduction, concepts)

MRP 1l with Just in Time

Choice of software

Making MRP Il system work

Achieving business objectives with MRP

Unit 5: Scheduling:

Factors Influencing Scheduling
Working and Scheduling Charts

Job Sequences:
» njob on two machines
» njob on three machines

Project Scheduling
Critical Ratio Schedulin
Assignment Techniques (Assignment - Model).

Unit 6: Capacity Planning:

Capacity Planning

Integrated Production Planning and Control
Push system

Pull system

Bottleneck

Hybrid Push-Pull system.

Text Reading:

1.
2.

3.

Jhamb L. C. “Production Planning and Control”, Pubeerest Publications, 2001.

Hari Raghu Rama Sharma, “Production Planning andtrGb Concepts and
Application”,

New Delhi: Deep and Deep Publications, 2000.

Suggested Reading:

1.

2.
3. McGraw-Hill Publications, 1994.

Bill Scott, “Manufacturing Planning System”, LondanMcGraw-Hill Publications,
1995.
George W. Plossl, O. R. Licky’s. “Materials Requment Planning”, New York:
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FT-305P. BUSINESS PROCESS REENGINEERING

Level of Knowledge Expert Knowledge

Course Objectives

* To help student understand the concepts of BusiRessess Reengineering, various
tools and models used for problems faced by marsager

Scheme of Examination:

Total Marks: 100
Internal Marks: 40
External Marks: 60

The external examination will have two Sectionsnll 8. Section A worth 40 marks will consist of
five theory questions out of which a student haattempt any four questions. Section B worth 20
marks will be Analytical (Case/Case let/Researc¢hafion/Practical problem). The questions may
or may not contain internal choice. The questi@rsitave one or more sub-parts.

Course Contents:

Unit 1: Introduction to BPR:

* What is BPR

» Philosophy of BPR

* Fundamental tenets of BPR
» Benefits & pitfalls of BPR

* Drivers to BPR.

Unit 2: Process reengineering framework:

* Opportunity assessment

* Planning the process re-engineering project.
Unit 3: Organizing for process reengineering:

* Process Focused organization

» Organization process reengineering team
Unit 4: Process analysis and design:

* Process analysis

* Process design.
Unit 5: Planning and implementing the transition:

* Planning the transition

* Implementing the transition

» Tracking and measuring process performance
» Success factors of BPR

» Managing barriers to BPR success
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Unit 6: Tools and techniques used in BPR:

» Case tools

*  Work flow systems

* Imaging technology

* Floware

* Business design facility tools
» Change management tools.

Unit 7: Risk and impact measurement:
* Role of IT in BPR

Suggested Reading:

1. Lon Roberts, “Process Re-engineering: The Key thiddng Breakthrough Success”,
New Delhi: Tata McGraw Hill, 1992.

2. Henry J. Johnson, Palrik Mchine, A.John Pandilepwiliam A Wheater, “Business
Process Reengineering: Breakpoint Strategies foké@&ominance”, Chichester, John
Wiley & Sons, 1993.
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FT-306P TOTAL QUALITY MANAGEMENT

Level of Knowledge Expert Knowledge

Course Objectives

* To help student understand the concepts of TotaliQuManagement, and Research of
various tools and models used for problems facechéyagers.

Scheme of Examination:

Total Marks: 100
Internal Marks: 40
External Marks: 60

The external examination will have two Sectionsnll 8. Section A worth 40 marks will consist of
five theory questions out of which a student haattempt any four questions. Section B worth 20
marks will be Analytical (Case/Case let/Researc¢hafion/Practical problem). The questions may
or may not contain internal choice. The questi@rsitave one or more sub-parts.

Course Contents:
Unit 1: Core Concepts of Total Quality Management:

» Customer focus
* Quality for profits right first time
» Cost of quality

Unit 2: TQM Organization:

e Structure

* Mangers role Models

* Recognition & awards

* Quality delivery process

» Pitfalls in Operationalising TQM and methods of ialog them

Unit 3: Learning from quality gurus:

» Edward Deming

* Joseph M. Juran

* Karon Ishikawa

» Philip B. Crosby

* William E. Conway and their applications in todassiness Environment

Unit 4: Bench marking:

» Definition

* Reason to benchmark

* What to benchmark

 BM process

» Pitfalls& criticism of BM

* Appraisal of TQM and improvement program
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Unit 5: Tools and techniques of TQM

Techniques for analyzing a quality process
Quiality Circles

Statistical process control

Failure Mode & Effect analysis

Computer aided inspection

Data collection & analysis

Six sigma and control chart

Unit: 6: Quality Award and certifications :

ISO-14000:

» Concepts

» Certifications

» methods and implementations

ISO-9000:
» Concepts
» Certifications
» Methods and implementations Malcolm Bal ridge Qyakward
» Methods and implementations Rajiv Gandhi Qualityahev

Text Reading:

1.

2.

3.

Sharma D.D Total Quality Management: Principles Practices &cass” New Delhi,
sultan chand & sons, 2004.

Sunraraju S.M. Total Quality Management: a premier” New Delhi, Tata McGraw -
Hill Publication,1999

Besterfield Dale H. Total Quality Management” New Delhi Pearsons
Education,2004.

Suggested Reading:

1.

2.

3.
4.

J. M. Juran and Frank M. Gryna Edgufan’s Quality Control Handbook”, New
York: McGraw-Hill Publications, 2001.

Tapan P. Bagchi,ISO 9000: Concepts, Methods and Implementation”Allahabad:
Wheeler Publishing.

Kit Sadgrove, Making TQM Work” , New Delhi: Kogan Page India P. Ltd., 2000.
Eugene L. Grant and Richards, Leavenwor8tatistical Quality Control” . New York:
McGraw-Hill Publications, 2000.
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